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1. �You’ll learn exactly how to create 
the final image.

The problem I’ve always had with other 
Photoshop books on designing is that 
they tend to show a really cool image, 
and I always think that’s what I am go
ing to learn, only to find out the author 
wants me to open a file that’s 60% 
done, and the tutorial only shows how 
to create that last 40%. But, what about 
that first 60%? Well, in this book, nearly 
every project either starts with a basic 
photo, a simple graphic, or a blank docu-
ment. So, when you flip through these 
pages, the end product you see is exactly 
what you are going to learn how to do…
from the beginning!

2. The order of things.
This book is designed so that you can 
open it up to any project and get start-
ed. You do not need to follow the chap-
ters in sequence. You will notice I tend 
to use some images or effects created 
earlier in the book on some of the other 
projects throughout the book. This is 
to show you the various uses of certain  
textures and brush effects. You’ll see  
these referenced throughout the book, 
directing you to where you can learn 
how to create them. But, while some 
projects make reference to other  
projects in the book, each project  
is self-contained.

I’m excited to present to you the Photoshop Down & Dirty Tricks for Designers book. The Photoshop Down & Dirty 

Tricks series has been immensely popular over the years, since it was started (with Photoshop 6) by best-selling 

author Scott Kelby. I’m incredibly honored that Scott has passed the torch on to me with this newest volume, and  

I couldn’t be happier to have had this opportunity to put some of my most popular techniques, and a lot of new 

ones, into this book. But, first, here are some important things you’ll want to know about the book:

12 Important Things About This Book

Before

After
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3. The D&D Designer’s Kit.
As a supplement to the book, I’ve  
created a Down & Dirty Designer’s  
Kit (http://kelbytraining.com/books 
/cs5dd/), featuring the start-up files 
for all of the projects throughout the 
book. I also added a few video tutori-
als that expand on certain concepts, 
especially for the 3D chapter. They will 
help you get a better idea of how the 
effects were created and modified. 
Also, make sure you check the website 
every so often for updates. If a new 
feature is released or added, I may up-
date a project or chapter and place a 
new video or PDF file on the website.

4. What about the fonts?
Like in previous editions of this  
book series, I tried to use common 
fonts available on most systems. But,  
in some designs, I used specialized 
fonts just to finish the effect. I have 
provided some fonts as part of the 
D&D Designer’s Kit downloads, but 
would also encourage you to go  
beyond what’s used in the projects 
and try other typefaces. One great 
resource for free fonts to experi-
ment with is www.dafont.com.

www.dafont.com
http://kelbytraining.com/books/cs5dd/
http://kelbytraining.com/books/cs5dd/
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5. What user level is this book?
While this book is classified as Beginner 
to Intermediate, it’s really for all user 
levels. Most projects do assume you 
have some working knowledge of 
Photoshop, although being an expert 
is not required. All you need is the 
desire to learn and a little patience. 
Also, most projects can be completed 
using almost any version of Photoshop, 
but some techniques make use of the 
newer features in CS5 (like in the  
3D chapter).

6. What file size should I use?
I always feel this needs to be address
ed, because it can confuse some people. 
Throughout this book, you’ll notice I  
create the files at small dimensions and 
low resolutions for several reasons. The 
most obvious is speed. And, since I was 
creating these images for the book, 
they did not need to be super-sized. 
Just remember: if you are re-creating 
these effects (with your own images) 
for actual print, then be sure to build 
them high-res.
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7. Get a pressure-sensitive tablet.
If you are a working designer, or an  
up-and-coming designer, then you 
should seriously consider a Wacom 
pressure-sensitive tablet. Photoshop  
has a number of features built specif
ically to take advantage of pressure 
sensitivity, which gives you unmatched 
control over your work, not to men-
tion a pen has a much more natural 
feel than a mouse.

8. �This is an effects book for  
all creatives.

This book is not a course in graphic  
design, but was written for designers, 
artists, and even creative photographers 
that want to be able to create eye-pop-
ping effects, either from scratch or using 
photos. True, the title says this book is 

“for Designers,” but this book is really for 
anyone who wants to learn how to make 
cool stuff in Photoshop.
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9. Use stock images.
One of the best secret weapons in any 
designer’s arsenal is the availability 
of stock photography, especially with 
as much as is available today. Most of 
the projects in this book utilize assets 
I found over at iStockphoto’s website 
(www.istockphoto.com). They have a 
vast collection of not just photos, but 
illustrated graphics, logos, and video 
clips—just about anything you need—
for very reasonable costs. A big thanks 
to the folks over at iStockphoto for 
helping me out with the images for 
this book.

10. The 3D Chapter.
As I mentioned before, most of the 
techniques in this book are relevant 
to most recent versions of Photoshop, 
although some features are specific 
to Photoshop CS5. However, the 3D 
chapter at the end of the book is only 
specific to Photoshop CS5 Extended (it 
has changed from CS4). Now, if you 
do not yet have CS5 Extended, then  
I would still suggest reading through  
the 3D chapter so you can get an idea  
of what is possible with 3D in Photo
shop. If you want to set yourself apart  
as a designer, you can only help your-
self by getting a little 3D experience!

www.istockphoto.com
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11. �Experiment, experiment, experiment!
While I do encourage you to follow the 
projects in the book step by step, be 
sure to experiment with your newfound 
knowledge. Think of these projects as a 
vehicle for a real project you’re working 
on. Chances are most of you won’t actu-
ally be creating a movie poster or title 
effect, but that doesn’t mean that the 
concepts can’t be applied to your own 
projects. Master the technique, and then 
add your own flavor to it. Most of the ef-
fects in this book were created through 
my own experimentation, both from 
things I’ve seen or things I just thought 
would look cool.

12. Be creative and have fun!
Finally, I just want to thank you for 
taking the leap forward and making 
this small investment in your creativity. 
Sometimes, just seeing what is possible 
is enough to light up your creative brain 
to new ideas. That is one of the reasons 
I had the final images in this book made 
as large as possible, so you can really take 
in what the final result is and get inspired. 
I hope you enjoy the fun times to be had 
within these pages and remember to be 
creative and have fun!

The splat brush, created in Chapter 1, was used in both of these designs





Many designers refer to commercial design work as the type that pays 

the bills, meaning it’s the work you do for commercial clients that doesn’t 

always lend itself to creative work. You are often limited by assets, time, 

and sometimes input from the client. They always seem to know what they 

don’t want, but never what they actually do want. However, it is under these 

conditions that you can really test your creativity. My first job out of design 

school was as an ad creator for a newspaper. Notice the title: Ad Creator, 

not Graphic Designer. The title alone limited my creativity, but I had to 

start somewhere. I pressed on to do the best I could and learned a lot. 

For one thing, I learned the value of speed. Because of daily deadlines,  

I was constantly in a pinch. As stressful as this sounds, I received more 

assignments beyond the scope of an ad creator because I showed higher 

proficiency. As a result, today I am able to infuse my own design style 

and still turn around projects, like commercial work, really quickly. So, 

don’t look at commercial work as a burden on your creativity. Use it to 

challenge your imagination to come up with creative solutions.

A Word from Our Sponsor
commercial effects

145Chapter 4Commercial Effects
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chapter 4

STEP ONE:
Go under the File menu, choose  
New, and create a new document  
that’s 9 inches wide by 12 inches tall  
at 125 ppi, and make sure the Back­
ground Contents pop-up menu is  
set to White.

STEP TWO:
Go under the Photoshop (PC: Edit) menu, 
under Preferences, and choose Guides,  
Grid, & Slices. Since we want to create 
four squares across, in the Grid section,  
enter 2.25 in the Gridline Every field and 
leave its pop-up menu set to Inches. 
Then, enter 1 in the Subdivisions field 
below. The default gray color to the right 
would work fine, but I prefer something 
more visible. So, click on the color swatch 
and choose a different color. Here, I’ve 
chosen a shade of green. Click OK when 
you’re done.

I actually saw this effect in a movie poster, but it definitely has a number of uses. Once the base grid is created, 

you can add just about any image for any purpose. While we’re creating the effect, try to be open-minded as to 

different ways of using this technique for different types of design scenarios.

Design with Grid Elements



147Chapter 4Commercial Effects

Continued

STEP THREE:
Go under the View menu, under Show, 
and choose Grid. In your image window, 
you should now see a 4-column grid 
going across the canvas.

STEP FOUR:
In the Toolbox, click-and-hold on the 
Rectangular Marquee tool, and choose 
the Single Row Marquee tool. Click on 
the first horizontal grid line at the top 
of the document and it will add a selec­
tion 1-pixel high and the width of the 
document, snapping to the grid line. 
Then press-and-hold the Shift key (to 
add to the existing selection) and click 
on the other horizontal grid lines to 
add selections to them.
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Chapter 4 Commercial Effects

STEP FIVE:
Next, go into the Toolbox and grab 
the Single Column Marquee tool (also 
nested beneath the Rectangular Mar­
quee tool) and use the same process  
to add selections to the vertical grid 
lines (remember to press-and-hold 
the Shift key to add to the existing 
selection). Once the selections are 
made, click on the Create a New Layer 
icon at the bottom of the Layers panel 
to create a new blank layer. Press D to 
set your Foreground and Background 
colors to their defaults of black and 
white, and then press Command-
Delete (PC: Ctrl-Backspace) to fill  
the selections with white. Press Com
mand-D (PC: Ctrl-D) to Deselect and 
then press Command-’ (apostrophe; 
PC: Ctrl-’) to turn off the grid.

STEP SIX:
Open the model shot we’re going to use 
in the design (or whatever image you 
might want to use). I liked this image, 
because of the lighting and the posi­
tioning of the model in the composition. 
Switch to the Move tool (V) and click-
and-drag (or copy-and-paste) this image 
into the grid layout file.
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Continued

STEP SEVEN:
Click-and-drag this image layer beneath 
the grid layer in the Layers panel. Then, 
position the image at the top edge of 
the canvas, like you see here.

STEP EIGHT:
Click on the Add Layer Mask icon at 
the bottom of the Layers panel to add 
a layer mask to the model layer and 
then select the Gradient tool (G) from 
the Toolbox. In the Options Bar, click 
on the down-facing arrow to the right  
of the gradient thumbnail and choose 
the Foreground to Transparent gradi­
ent (the second gradient from the left  
in the top row), and then click on the 
Linear Gradient icon to the right of  
the gradient thumbnail. Press X to set 
your Foreground color to black, and 
then click-and-drag the gradient up 
just a little bit, starting at the bottom 
edge of the photo, to fade the image 
into the white background.
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STEP NINE: 
Now, to make the grid lines a little 
thicker, we’ll use a simple layer style. 
Click on your grid layer (Layer 1) to 
make it active, then click on the Add  
a Layer Style icon at the bottom of the 
Layers panel and choose Stroke. Click  
on the Color swatch and set the color  
to white. Then, set the Size to 2 px 
and make sure the Position pop-up 
menu is set to Outside. Click OK.

STEP 10:
Now, click back on the layer of the 
model to make it active and press Com
mand-J (PC: Ctrl-J) to make a duplicate 
of it. Then, press Command-Shift-U 
(PC: Ctrl-Shift-U) to remove the color 
from this duplicate layer. Go under the 
Filter menu, under Distort, and choose 
Diffuse Glow. Set the Graininess to 3,  
the Glow Amount to 5, and the Clear 
Amount to 10. This will blow out the 
highlights a bit and give us a stylish 
grain over the whole image. Click OK. 
(Note: These settings will vary with 
different images, so be sure to experi­
ment with other settings to get the 
look you want.)
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Continued

STEP 11:
As a result of the Diffuse Glow filter, 
the image is left a little flat. However, 
you can tighten up the contrast a bit 
by pressing Command-L (PC: Ctrl-L) 
and running a simple Levels adjust­
ment. You can see here, I’ve adjusted 
the Input Levels shadows (black) and 
midtones (gray) sliders to darken the 
shadow areas. Next, change the layer’s 
blend mode to Soft Light, which will 
add some stylish contrast to the image.

STEP 12:
Now, back to the grid layer. Click on 
it to activate it again, then select the 
Magic Wand tool from the Toolbox (or 
press Shift-W until you have it), and 
click inside one of the squares. Press- 
and-hold the Shift key and select two 
other squares (like you see here or 
however many you’d like). Once the  
selections are made, create a new 
blank layer, fill the square selections 
with white, and then deselect.
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STEP 13: 
Click back on the grid layer and use the 
Magic Wand tool, once again, to select 
three more squares. Then, with your 
Foreground and Background colors set 
to their defaults of black and white, 
click on the Create New Adjustment 
Layer icon at the bottom of the Layers 
panel and choose Gradient Map. This 
will make the selected grid squares 
black and white like you see here, giv­
ing us a very cool finished effect. Feel 
free to play around with other adjust­
ments or colors to get different results.

STEP 14:
Finally, just drop in some text (here,  
I used different styles of the Futura 
font) and you have a finished layout. 
You can see here how I used the white 
squares to act as frames for the text.
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Final Image
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chapter 4

STEP ONE:
Open the image of the model.  
Notice it was shot on a green screen. 
We won’t need to extract the subject 
here, because we’ll be working close 
enough in on the face that the green 
screen will not be seen anyway. So, 
press Command-A (PC: Ctrl-A) to 
select the entire image and then press 
Command-C (PC: Ctrl-C) to Copy it.

STEP TWO:
Press Command-N (PC: Ctrl-N) and 
create a new document that’s 9 inches 
wide by 12 inches tall at 100 ppi. Click 
on your Foreground color swatch and 
set your Foreground color to a light 
beige (I chose R: 186, G: 179, B: 160) and 
then press Option-Delete (PC: Alt-
Backspace) to fill the Background  
layer with this color.

Halftone effects are certainly nothing new—designers have been using them for years—yet they never seem  

to go out of style. I saw this effect in a magazine and thought it had a cool look to it. Building on a technique  

I did a while back, I’ve added a couple new things to spice it up a bit.

Halftone Image Effect
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Continued

STEP THREE:
Press Command-V (PC: Ctrl-V) to 
Paste the high-res model shot in the 
new document. It will appear very 
large, because the new document it­
self is a much smaller resolution than 
the image. This actually is okay, though, 
because we want the image big any­
way. In fact, as you can see here, the  
face fills the canvas, leaving none of  
the green screen visible. Go into Free  
Transform (press Command-T [PC: 
Ctrl-T]) and, while pressing-and-hold­
ing the Shift key, click-and-drag a 
corner point inward to bring more of 
her face into the image, then move 
your cursor outside the bounding box, 
and rotate it just slightly to the left to 
make the subject more balanced in the 
composition. Once the image is in place, 
press Return (PC: Enter) to commit 
the transformation.

STEP FOUR:
Now, we don’t need this image to  
be in color, so we’ll convert it to black 
and white. While there are numerous 
methods for doing this, I like to use 
the Gradient Map adjustment, because 
it leaves the image with a fair bit of  
contrast. (If I were just creating a black-
and-white photo, then I would prob­
ably use Camera Raw or the Black & 
White adjustment.) Press D to set your 
Foreground and Background colors to  
their defaults of black and white, then 
go under the Image menu, under Ad­
justments, and choose Gradient Map. 
Just click OK when the dialog opens.
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STEP FIVE:
For the effect we’re creating here, the 
subject is a little dark. However, rather 
than run a Levels adjustment, which will 
affect the whole image, I’d prefer to 
lighten the image in specific areas. So, 
click on the Create a New Layer icon at 
the bottom of the Layers panel to cre­
ate a new blank layer above the model 
layer, then select the Gradient tool (G) 
from the Toolbox. In the Options Bar, 
click on the down-facing arrow to the 
right of the gradient thumbnail and 
choose the Foreground to Transparent 
gradient (the second one from the left 
in the top row) in the Gradient Picker, 
and then click on the Radial Gradient 
icon (the second icon to the right of 
the gradient thumbnail). Set your Fore­
ground color to white by pressing X,  
then change the layer’s blend mode to 
Soft Light, and click-and-drag the gra­
dient in the dark areas of the image to 
lighten them (here, I mainly lightened 
her hair, the left side of her face, and 
her neck). This will show more of the 
halftone effect in a moment.

STEP SIX:
With this gradient layer active in  
the Layers panel, Command-click (PC: 
Ctrl-click) on the model layer beneath 
it to select them both. Then, Right-
click on one of the layers and choose 
Convert to Smart Object from the 
pop-up menu.
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Continued

STEP SEVEN:
Now, press D to set your Foreground 
color to black, then, from the Filter 
menu, under Sketch, choose Halftone 
Pattern. From the Pattern Type pop-up 
menu, choose Dot, then set the Size to  
2 and the Contrast to 0. Click OK.

STEP EIGHT:
Go back under the Filter menu, again, 
this time under Artistic, and choose 
Poster Edges. Set the Edge Thickness 
to 0, the Edge Intensity to 1, and the 
Posterization to 6. Click OK. This will 
intensify the halftone effect quite  
a bit, but it could stand a little bit  
more contrast.



158 Chapter 4 Commercial Effects

STEP NINE:
Here’s a pretty cool trick to enhance 
the contrast a bit more: With the layer 
being a smart object, it automatically 
applies the filters as smart filters, al­
lowing you to modify their appearance 
without having to reapply them. So, 
in the Layers panel, double-click on 
the icon to the right of the Halftone 
Pattern filter to open the filter’s Blend­
ing Options. This dialog allows you to 
modify the opacity and blend mode  
of just this filter effect. In this case, 
change the blend Mode to Hard Light 
and you can see the halftone effect 
become a little more clearly defined—
just through a single blend mode.  
Click OK when you’re done.

STEP 10:
Now, change the layer’s blend mode 
to Multiply to blend the color of the 
Background layer with the halftone 
layer. By using Multiply, the dark areas 
remain, while the lighter areas are  
letting the Background layer color 
show through. Then, drop the layer’s 
Opacity down to 90%.
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Continued

STEP 11:
Let’s add a cool text element to finish 
the design. Open the file of the paper 
texture. Then get the Rectangular 
Marquee tool (M) from the Toolbox 
and draw a horizontal rectangle in 
the middle of the canvas, like you  
see here. Press Command-J (PC: 
Ctrl-J) two times to create two  
layers of the selected area.

STEP 12:
Click on the Eye icons to the left of  
the Background layer and the top copy  
layer (Layer 1 copy) to turn them off,  
leaving just the bottom copy layer 
(Layer 1) visible. Then, click on the bot­
tom copy layer to make it active. Press 
Command-U (PC: Ctrl-U) to open the 
Hue/Saturation dialog and turn on the 
Colorize checkbox. Set the Hue to 50, 
the Saturation to 25, and the Lightness 
to 50. This will give the texture an off-
white color. Click OK.
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STEP 13:
Next, turn the top copy layer (Layer 
1 copy) back on, and then click on it 
to make it active. Press Command-U 
(PC: Ctrl-U) again to bring up the Hue/
Saturation dialog and, this time, set 
the Hue to 23, the Saturation to 49, 
and the Lightness to –3 (don’t forget  
to turn on the Colorize checkbox, again, 
as well). This will add a subtle orange 
hue to the texture.

STEP 14:
Get the Polygonal Lasso tool from the 
Toolbox (or press Shift-L until you have 
it) and click in the top-left corner of the 
top texture layer, just a little inside the 
outer edge. Then, continue the selec­
tion around the rectangle just clicking 
in a random spot in each corner mak­
ing the selection uneven all the way 
around. Press Command-Shift-I (PC: 
Ctrl-Shift-I) to Inverse the selection, 
then press Delete (PC: Backspace) to  
reveal the texture layer below around 
the edge, creating a border effect. Press 
Command-D (PC: Ctrl-D) to Deselect.
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Continued

STEP 15:
Now get the Horizontal Type tool (T) 
from the Toolbox and click on the canvas 
to create a text layer. Here, I typed the 
word “TABS” in Helvetica Black Oblique 
and set the font size to occupy a large 
area of the texture. Next, select the 
text by Command-clicking (PC: Ctrl-
clicking) on the text layer’s thumbnail  
in the Layers panel. Then, click on the 
top texture layer to make it active and 
press Delete. Turn off the text layer 
and you’ll be able to see through the 
text to the bottom texture layer below. 
You can now deselect.

STEP 16:
To give this top texture layer a sense 
of separation from the texture layer 
below, let’s add a Drop Shadow layer 
style. Click on the Add a Layer Style 
icon at the bottom of the Layers panel 
and choose Drop Shadow. Feel free  
to change the angle of the shadow,  
if you like (I changed it to 30°, but  
the other default settings will work 
fine here), and click OK.
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STEP 17: 
Finally, Command-click (PC: Ctrl-click) 
on the bottom texture layer to select 
both texture layers. Then, Right-click on 
one of the layers and choose Convert 
to Smart Object to convert these lay­
ers into a smart object to bring over 
to our halftone image.

STEP 18:
Go back to the halftone image and, 
using the Move tool (V), drag-and-
drop this text graphic onto the layout. 
Position it at the bottom of the image 
and there you have it!
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Final Image
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chapter 4

STEP ONE:
We’ll start with this underwater image 
I downloaded from iStockphoto (www 
.istockphoto.com). It seems to fit with 
what we're going for here, so we’ll start 
building the design around this image.

STEP TWO:
Now press Command-N (PC: Ctrl-N) 
and create a new blank document  
measuring 12 inches wide by 8 inches 
tall at 100 ppi. Press D to set your Fore­
ground color to black, and then press 
Option-Delete (PC: Alt-Backspace) 
to fill the Background layer with black. 
Then, use the Move tool (V) to click-
and-drag the underwater image into 
this new document. Position it so the 
light beams are just coming in at the 
top-left edge of the canvas area, like 
you see here, and use Free Transform 
(press Command-T [PC: Ctrl-T]) to in­
crease the size of the beams a bit. Press 
Return (PC: Enter) when you're done.

If you’ve ever flipped through some of the high-end fashion magazines, there are always a few of those classy 

watch ads. I like them because they have a very sleek look to them. Here, I thought we would take a different 

approach and create a watch ad that gives an underwater perspective.

Cool Watch Ad

©
IS

T
O

C
K

P
H

O
T

O
/S

E
B

A
S

T
IA

N
 M

E
C

K
E

LM
A

N
N

www.istockphoto.com
www.istockphoto.com
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Continued

STEP THREE:
Next, click on the Add Layer Mask icon 
at the bottom of the Layers panel to 
add a layer mask. Then, get the Gra­
dient tool (G) from the Toolbox and,  
in the Options Bar, click on the down-
facing arrow to the right of the gradient 
thumbnail and choose the Foreground 
to Transparent gradient (the second 
gradient from the left in the top row). 
With your Foreground color set to black, 
click-and-drag from outside the under­
water image to just over the edge of it 
to fade it into the black background 
on the bottom and right side.

STEP FOUR:
Now, open the image of the watch. 
Here, we have one that is on a black 
background and already has a reflection 
that we can work with. Since the overall 
composition is going to be mostly black, 
it will be easy to blend. So, go ahead 
and click-and-drag or copy-and-paste 
this image into the working layout.
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STEP FIVE:
Position the watch in the lower-right 
area of the composition, like you see 
here, and use Free Transform to make it 
a little bigger. Change the layer’s blend 
mode to Screen to make the watch’s 
black background blend into the work­
ing background. Then, add a layer mask 
and use the Foreground to Transparent 
gradient again to fade the reflection 
a little bit (click at the bottom of the 
reflection and drag up).

STEP SIX:
Now, we need to create a more visible 
surface for the watch to sit on. True, 
there is a reflection, which helps, but 
it’s not enough. I really want to see 
the refracted light reflection on the 
same surface the watch seems to sit 
on. For that I am going to use an old 
trick from years ago that will work 
great here. Make sure your Foreground 
and Background colors are the default 
black and white, and then click on the 
Create a New Layer icon at the bot­
tom of the Layers panel to create a 
new blank layer. Next, go under the 
Filter menu, under Render, and choose 
Clouds. There’s no dialog for this filter—
its results will just reflect in your image 
window (as shown here).
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Continued

STEP SEVEN:
Go under the Filter menu, once  
again, this time under Blur, and 
choose Gaussian Blur. Set the  
Radius to 10 pixels and click OK.

STEP EIGHT: 
Again, go under the Filter menu, this 
time under Artistic, and choose Plastic 
Wrap. Set the Highlight Strength to 15,  
the Detail to 6, and the Smoothness 
to 11. You can see the effect starting 
to take shape at this point. Click OK 
when you’re done.
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STEP NINE:
Now, let’s change the color of this  
texture layer to better match our  
background image. Press Com
mand-U (PC: Ctrl-U) to open the  
Hue/Saturation dialog. Turn on the 
Colorize checkbox and increase the  
Hue to 190, and then click OK.

STEP 10: 
Now, in the Layers panel, click-and-
drag this texture layer just above the 
Background layer. Then, go into Free 
Transform mode and click-and-drag 
the top-middle control handle down  
to the bottom edge of the watch. 
Press Return (PC: Enter) to lock in  
your transformation.
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Continued

STEP 11:
Press Command-L (PC: Ctrl-L) to open 
the Levels dialog and move the Input 
Levels shadows (black) and midtones 
(gray) sliders to the right to boost the 
contrast, making it look more like light 
reflecting on the ocean floor. Click OK.

STEP 12:
Change the layer’s blend mode to 
Screen and lower its Opacity to 75%. 
Then, add a layer mask and blend the 
hard edge at the top of the texture  
layer into the background with a Fore­
ground to Transparent gradient (like 
we did with the watch reflection, but 
this time, dragging from above the  
texture layer downward).
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STEP 13:
Now, with the floor texture in place,  
I can see that the area around the base 
of the watch could use a subtle light 
enhancement to bring out the reflec­
tion a bit more. Command-click (PC: 
Ctrl-click) on the Create a New Layer 
icon at the bottom of the Layers panel 
to place a new layer under the currently 
active one. Get the Eyedropper tool (I) 
from the Toolbox and click in the light 
beam area of the image to sample the 
teal color, making it your Foreground 
color. Then, get the Elliptical Marquee 
tool (press Shift-M until you have it), 
draw a long oval selection just below 
the watch, and press Option-Delete 
(PC: Alt-Backspace) to fill the selec­
tion with the sampled Foreground color.

STEP 14:
Press Command-D (PC: Ctrl-D) to De­
select. Then, go under the Filter menu, 
under Blur, and choose Gaussian Blur. 
Set the Radius to 30 pixels and click OK. 
Next, just drop the layer’s Opacity down 
to 75% and, as you can see, we have a 
nice, subtle light effect that blends with 
the background quite nicely.
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Continued

STEP 15:
Now let’s add some more of that teal 
color to the surrounding area to get 
more of that aquatic underwater feel. 
Create a new blank layer at the top of 
the layer stack, then get the Gradient  
tool with the Foreground to Transparent 
gradient again, but this time, click on 
the Radial Gradient icon in the Options 
Bar (the second icon to the right of the  
gradient thumbnail). With your Fore­
ground color still set to the same teal 
color we used a moment ago, click-and-
drag a couple of gradients in the upper-
right and bottom-left corners. Then, 
lower the layer’s Opacity to 75%.

 

STEP 16:
Next, let’s add a diver in the background. 
Since it will merely be a silhouette, a sim­
ple graphic of a diver will do fine. Here, 
I found a set of diver images at iStock­
photo. This way, I have a set I can choose 
from for future use. Get the Lasso tool 
(L) from the Toolbox and draw a selec­
tion around the diver in the upper-right 
corner, then press Command-C (PC: 
Ctrl-C) to Copy the selected graphic.
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STEP 17:
Press Command-V (PC: Ctrl-V) to 
Paste the diver into your working  
layout, then go into Free Transform, 
press-and-hold the Shift key, and 
decrease the size of the diver (press 
Command-0 [zero; PC: Ctrl-0] to 
reach the corner handles). Press 
Return (PC: Enter) to lock in your 
transformation. In the Layers panel, 
position this layer under the gradient 
layer we just created back in Step 15. 
Then, use the Move tool to move the 
diver in the middle of the light beams. 
To get rid of the white background 
area, just change the layer’s blend 
mode to Multiply and drop its 
Opacity to 60%.

STEP 18:
Now, because the diver is underwater 
and is in the distance, the edge detail 
would not realistically be as sharp. So, 
go under the Filter menu, under Blur, 
and choose Gaussian Blur. Set the 
Radius to 1 pixel and click OK.
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Continued

STEP 19:
Let’s add a bubble effect to finish 
off the diver in the water. Here, we 
have a simple image of bubbles on a 
white background. To quickly extract 
them, create a selection by pressing 
Command-I (PC: Ctrl-I) to Invert the 
image, then go into the Channels panel 
(Window>Channels) and Command-
click (PC: Ctrl-click) on the RGB channel. 
Go to the Layers panel and create a 
new blank layer. Press D, then X to set 
your Foreground color to white, and 
press Option-Delete (PC: Alt-Backspace) 
to fill the selection with white. Press 
Command-D (PC: Ctrl-D) to Deselect.

STEP 20:
Next, click-and-drag or copy-and-paste 
the selected bubble layer into the work­
ing layout and place it above the diver 
layer in the Layers panel. Go into Free 
Transform mode and scale and position 
the bubbles just above the diver, like 
I have them here. Finally, change the 
layer’s blend mode to Overlay.
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STEP 21:
Okay, we are almost done. Looking at 
the overall layout, I can see that the 
upper-right corner area could use a 
little something. To go along with the 
whole diving theme, we have a cool 
nautical map to add as another back­
ground element. Open the nautical 
map image and remove the color by 
pressing Command-Shift-U (PC: Ctrl-
Shift-U). Then, invert the image, like 
we did with the bubbles. 

STEP 22:
Now, go ahead and click-and-drag or 
copy-and-paste the map image into the 
working layout, and use the Move tool 
to position it in the upper-right corner, 
making sure its layer appears below the 
teal radial gradient layer in the Layers 
panel. Then, add a layer mask, get the 
Gradient tool, with the Foreground to 
Transparent Linear gradient again, and 
with your Foreground set to black, fade 
the edges of the map image. Change the 
blend mode to Linear Dodge (Add),  
and then lastly, to soften the effect, 
drop the layer’s Opacity down to 50%. 
This will subtly blend the map graphic 
into the background.
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Continued

STEP 23:
Let’s finish the whole design off with 
some text. Start by selecting the Hori­
zontal Type tool (T) from the Toolbox 
and creating a text layer. Click on the 
color swatch in the Options Bar and 
enter R: 224, G: 146, B: 47 in the Color 
Picker. Here, I stacked the words “AQUA 
TIME” in Eurostile (T1) Extended 2  
at almost 73 points for AQUA and at  
almost 53 points for TIME.

STEP 24:
Create a new blank layer below the 
text layer. Get the Rectangular Marquee 
tool (M), and draw a thin-line selection 
across the document, in between the  
lines of text. Set your Foreground color 
to the same color used for the text and  
then press Option-Delete (PC: Alt-Back­
space) to fill the line with that color, 
then deselect. (Note: To get both words 
to line up with the line you just created,  
use the Move tool to move the bottom 
of AQUA onto the line and then select 
TIME with the Horizontal Type tool, and 
press Option-Up Arrow key (PC: Alt-
Up Arrow key) to bring the top of it 
up to the line.) Now, Command-click (PC: 
Ctrl-click) on both the line and text lay­
ers so both are selected, and then from 
the Layers panel’s flyout menu, choose 
Convert to Smart Object to convert 
them into a single Smart Object layer.
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STEP 25:
Now, let’s dress up the text with layer 
styles. With the Smart Object layer  
active in the Layers panel, click on the 
Add a Layer Style icon at the bottom  
of the panel and choose Inner Shadow. 
Use the settings shown here to add 
some depth to the text.

STEP 26:
Next, click on Gradient Overlay on  
the left side of the dialog to turn it  
on, and just change the Blend Mode  
to Soft Light.
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Continued

STEP 27:
Lastly, click on Outer Glow on the left 
to turn it on, and set this Blend Mode 
to Overlay and the Opacity to 100%. 
Click on the color swatch and change 
the color to white. Then, down in the 
Elements section, increase the Spread 
to 25% and set the Size to around  
105 px. This will give the glow a  
subtle halo effect. Click OK.

STEP 28:
Now we need to mask the line where  
it goes over the watch. So, get the Ellip­
tical Marquee tool (press Shift-M until 
you have it) and draw a long oval selec­
tion over the line where it goes over 
the watch.
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STEP 29:
Press Q to put the selection in Quick 
Mask mode. (Note: If the masked area is 
in red, rather than the selection, double-
click on the Quick Mask icon at the bot­
tom of the Toolbox to open the Quick 
Mask Options dialog and change Color 
Indicated to Selected Areas.) Go under 
the Filter menu, under Blur, and choose 
Gaussian Blur. Set the Radius to 5 pix­
els and click OK.

STEP 30:
Press Q again to go back to the march­
ing ants selection, then Option-click 
(PC: Alt-click) on the Add Layer Mask 
icon at the bottom of the Layers panel. 
This will give the illusion that the line 
goes behind the watch.
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Continued

STEP 31:
Finish off the image by adding some 
more text in the top right. Here, I set 
some in Bank Gothic Light, and then 
added a black Outer Glow layer style 
with the settings shown here.
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Final Image
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chapter 4

Continued

STEP ONE:
To start building the wood frame,  
we’ll use a stock image of some wood 
planks that have a sort of aged look 
that will work perfectly for this design. 
Plus, there are several planks, which will 
give us some variation. Start by getting 
the Rectangular Marquee tool (M) from 
the Toolbox. Then, draw a selection over  
any one of the planks in the image. Here,  
I chose the fourth one from the left.  
Once the selection is made, press Com
mand-C (PC: Ctrl-C) to Copy it.

STEP TWO:
Press Command-N (PC: Ctrl-N) 
and create a new document that  
is 14 inches wide by 7 inches tall at 
125 ppi. Then, press Command-V 
(PC: Ctrl-V) to Paste the wood plank 
selection in the new document. Press 
Command-T (PC: Ctrl-T) to go into 
Free Transform mode, Right-click in­
side the bounding box, and choose 
Rotate 90º CW to rotate the plank, 
making it horizontal.

This effect I saw, once again, in a magazine ad. It was an advertisement for beach sandals. I was really drawn to 

the wood frame effect and liked the whole surfer feel of the ad. Once you see how easy it is to create this effect, 

you’ll really see how much fun you can have configuring the wood frame in different ways. Plus, it just looks cool!

Wood Frame Surf Ad
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STEP THREE:
Move the plank to the top edge of the 
canvas, then press-and-hold the Option 
(PC: Alt) key (to scale the object from 
the center), click on the right-middle 
control handle, and drag to stretch the 
plank to the right edge of the canvas. 
The left side will scale at the same time. 
Then, release the Option key, click on 
the bottom-middle control handle, and 
drag it up slightly to make the wood 
plank a little thinner. Press Return (PC: 
Enter) to lock in your transformation.

STEP FOUR:
Now, repeat the last few steps to add  
a different plank from the source file to 
the bottom of the working layout, like 
I have here.
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Continued

STEP FIVE:
Use the same process to add three more 
different vertical planks to the layout—
one on each end and another about  
9 inches from the left side. In the Layers 
panel, move the vertical plank layers be­
neath the horizontal plank layers. When 
all the planks are in place, Command-
click (PC: Ctrl-click) on each plank layer to 
select them all, then Right-click on one 
of the layers and choose Convert to 
Smart Object from the pop-up menu 
to merge them all into a smart object.

STEP SIX:
Now open the other wood grain file 
(shown here), press Command-A (PC: 
Ctrl-A) to select the entire image, then 
copy-and-paste it into the working 
layout. Once it’s there, move its layer 
beneath the wood plank Smart Object 
layer, and then position this wood grain 
in the rectangle area on the right side 
of the image. Go into Free Transform 
mode and scale it, if necessary, to fit  
it in the area.
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STEP SEVEN:
Let’s apply a color effect to the wood 
grain with a simple layer style. Click  
on the Add a Layer Style icon at the  
bottom of the Layers panel and choose 
Color Overlay. Click on the color swatch, 
choose R: 36, G: 79, B: 63, and click OK in 
the Color Picker to get a cool green color. 
Then, set the Blend Mode to Color and 
click OK.
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Continued

STEP EIGHT:
Open the surfer image, which we’ll 
add to the other side of the layout. 
Copy-and-paste the image into your 
working layout and, in the Layers 
panel, move the surfer layer beneath 
the wood grain layer. Go into Free 
Transform, if needed, and scale and  
position it within the frame on the  
left side as I have here.

STEP NINE:
Let’s create some depth between the 
surfer and wood grain images and the 
wood plank frame by adding a basic 
Drop Shadow layer style. Click back on 
the wood plank Smart Object layer in 
the Layers panel, then click on the Add 
a Layer Style icon and choose Drop 
Shadow. Use the settings shown  
here and click OK.
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STEP 10:
Using the same process we used for 
the initial wood plank frame, follow 
the first few steps of this project again 
to create another wood plank frame 
element, like I have here. Then, just like 
before, convert it to a smart object and 
position it over the surfer image to the 
left of the green wood grain area (but 
make sure it appears beneath the origi­
nal wood plank and wood grain layers 
in the Layers panel). This is going to con­
tain the product logo. (Note: I included 
the wood grain layer this time, which 
I added a black Color Overlay layer style 
to, when I converted the wood plank 
layers into a smart object.) To finish this 
new element off, add the same Drop 
Shadow layer style that we just added 
to the wood plank frame by Option-
clicking (PC: Alt-clicking) on the Drop 
Shadow layer style beneath the original 
wood plank frame layer and dragging it 
to the new frame layer. This will copy it 
to the new frame layer.

STEP 11:
Now we are ready to add the prod­
uct for our ad. Since we’re creating 
a surf-style ad, it seems like the right 
setting for some beach footwear. Here, 
we’ll use a generic product shot of a 
pair of flip-flops, which will work well 
for this layout. Select the flip-flops by 
getting the Quick Selection tool (W) 
from the Toolbox and then painting 
over them. Once they’re selected, press 
Command-J (PC: Ctrl-J) to copy the 
selection up onto a new layer. Extract­
ing from a white background like this 
will often leave little artifacts around 
the edges. To get rid of them, just go 
under the Layer menu, to the very 
bottom, under Matting, and choose 
Defringe. You really don’t need to  
set the Width to anything more than  
1 or 2, but go ahead and enter 3 for 
good measure and click OK.
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Continued

STEP 12:
Press Command-J again to duplicate 
this layer, and then remove the color 
by pressing Command-Shift-U (PC: 
Ctrl-Shift-U). Change the desaturated 
layer’s blend mode to Soft Light and 
drop the Opacity to 75%. This will 
boost the contrast and make the  
colors pop a little more.

STEP 13:
Press Command-E (PC: Ctrl-E) to 
merge this layer with the original 
beneath it. Then, Command-click  
(PC: Ctrl-click) on the merged layer’s 
thumbnail to select it, and copy-and-
paste this layer into the working lay­
out. Place the product image at the 
top of the layer stack and use Free 
Transform to decrease its size, as you 
see here, then add a Drop Shadow 
layer style using the settings shown 
here as a finishing touch. Notice that 
I have the Drop Shadow Blend Mode 
set to Color Burn, which greatly 
saturates the colors in the shadow, 
giving it a more stylized look.
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STEP 14:
Now, let’s add a couple more planks 
to finish off the design. Go back to the 
original wood plank image we started 
with and grab the Rectangular Marquee 
tool again. Draw a selection over the 
second plank from the right and then 
press Command-C (PC: Ctrl-C) to 
Copy the selected area.

STEP 15:
Go to the Channels panel (under the 
Window menu) and click on the Create 
New Channel icon at the bottom of the  
panel. With the selection still active, 
press Command-V (PC: Ctrl-V) to 
Paste the selection into the channel, 
then press Command-D (PC: Ctrl-D)  
to Deselect.
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Continued

STEP 16:
Now, get the Gradient tool (G) from 
the Toolbox and then, in the Options 
Bar, click on the down-facing arrow next 
to the gradient thumbnail and choose 
the Foreground to Transparent gradient 
(the second gradient from the left in the 
top row) from the Gradient Picker. Make 
sure the Linear Gradient icon is selected 
(the first icon to the right of the gradient 
thumbnail) and change the blend Mode 
to Overlay. With your Foreground color 
set to black, starting at the top of the 
plank, click-and-drag the gradient down 
just a little bit. With the Gradient tool in 
Overlay mode, the edge will have more 
contrast than normal. Click-and-drag 
two or three more times to increase the 
contrast, making the edge more frayed. 
Do this same thing to the bottom edge 
of the plank, as well.

STEP 17:
Next, open the Levels dialog by press­
ing Command-L (PC: Ctrl-L), then raise 
the contrast so much that it forces the 
plank to mostly white. Here, I dragged 
the Input Levels highlights (white) slider 
all the way to the left and dragged the 
Input Levels shadows (black) slider just 
a little bit to the right. Pay close atten­
tion to the top and bottom edges of the 
plank—you should see them get sharper. 
There might be some small black lines 
that appear on the plank, but they are 
not a big deal.
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STEP 18:
Click on the RGB composite channel  
at the top of the Channels panel, 
then from the Select menu, choose 
Load Selection. Make sure the 
Alpha 1 channel we just created  
is selected in the Channel pop-up 
menu and click OK.



191Chapter 4Commercial Effects

Continued

STEP 19:
Press Command-J (PC: Ctrl-J) to copy 
the selected area to a new layer. Then, 
click on the Eye icon to the left of the 
Background layer to turn it off and see 
the new plank with frayed edges. If 
necessary, you can increase the den­
sity by duplicating the layer two or 
three times, then merging them all 
back together into one layer. To give 
the plank a different color, open the 
Hue/Saturation dialog by pressing 
Command-U (PC: Ctrl-U). Turn on  
the Colorize checkbox, set the Hue  
to 45 and the Saturation to 50, and 
click OK.

STEP 20:
Now, bring this new element into the 
layout, go into Free Transform, resize it, 
rotate it, and use it as a surface for the  
text to sit on. I simply used the same 
element in both cases here, by making 
a duplicate of the layer and rotating it 
just slightly for variation. Then, I added 
a Drop Shadow layer style to them using 
the settings shown here. Finally, I added 
a logo and some text to finish it off, as 
you’ll see in the final image. (I used the 
fonts Futura, Myriad Pro, and Mama 
Regular. Oh, and in case you were won­
dering, “Sörf” is Turkish for “Surf”.)
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Final Image
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chapter 4

Continued

STEP ONE:
As usual, we’ll start our video game 
cover design with the background image.  
Open the car image shown here. It’s a 
great shot, but we need to spice it up  
a little bit. First, let’s get it into the layout 
by pressing Command-A (PC: Ctrl-A)  
to Select All, then Command-C (PC: 
Ctrl-C) to Copy it to the clipboard.

STEP TWO:
Press Command-N (PC: Ctrl-N) to 
create a new document, and make it 
7 inches wide by 10 inches tall at 100 ppi. 
Then, paste the car image into the new 
document by pressing Command-V (PC:  
Ctrl-V). Press Command-T (PC: Ctrl-T) 
to go into Free Transform mode, press-
and-hold the Shift key, and click-and-
drag a corner point to resize the image. 
Then, position it in the composition like 
you see here. Press Return (PC: Enter) 
to lock in your transformation.

One of the best places to find inspiration, aside from movie posters and magazines, is video game covers. In this 

project, we’ll combine a number of different effects from several video game covers that I really like. It really 

demonstrates well how you can combine images with text elements in a non-destructive way with smart objects.

Video Game Cover Design
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STEP THREE:
Here’s another cool trick for boosting 
the contrast of an image: click on the 
Create New Adjustment Layer icon at 
the bottom of the Layers panel and 
choose Levels. Do not make a single 
change in the Adjustments panel. Just 
change the Levels adjustment layer’s 
blend mode to Overlay. This alone will 
make the colors really pop. I don’t re­
ally know why, but hey, it works for me.

STEP FOUR:
To go along with the whole racing 
theme of the video game cover we’re 
creating, open the checkered flag image 
and use the Move tool (V) to drag it or 
copy-and-paste it (the way we did with 
the background image) into the working 
layout. Position it in the top left of the 
layout (as shown here).
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Continued

STEP FIVE:
Add a layer mask to the checkered flag 
layer by clicking on the Add Layer Mask 
icon at the bottom of the Layers panel. 
Then, get the Gradient tool (G) from the  
Toolbox, click on the down-facing arrow 
to the right of the gradient thumbnail 
in the Options Bar, and choose the Fore­
ground to Transparent gradient (the 
second gradient from the left in the 
top row). With your Foreground color 
set to black, click-and-drag diagonally 
from the bottom right to the top left  
to fade the checkered flag into the 
background, like I’ve done here.

STEP SIX:
Now, on to the text objects. Create an­
other new document that is 12 inches 
wide by 3 inches tall at 100 ppi. Grab 
the Horizontal Type tool (T) from the 
Toolbox and click in your new document 
to create a text layer. Here, I set the color 
to gray in the Options Bar, and typed 
the word “GEAR” using Serpentine Bold. 
Then, I went into Free Transform and 
scaled it to cover almost the entire 
image area.
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STEP SEVEN:
Before we add some layer style  
effects to the text, we need to  
define a couple images as textures 
that we’ll apply through layer styles. 
The first is this seamless carbon fiber 
pattern. Open the file, and then go 
under the Edit menu and choose 
Define Pattern. Give the pattern  
a name and click OK. We’ll use this  
as a background element.

STEP EIGHT:
Next, open the other car image on the 
blue background and define it as a pat­
tern, as well. We’ll apply this image to 
the text through a layer style.

©
IS

T
O

C
K

P
H

O
T

O
/A

R
E

N
A

 C
R

E
A

T
IV

E
©

IS
T

O
C

K
P

H
O

T
O

/M
A

R
K

 E
V

A
N

S



197Chapter 4Commercial Effects

Continued

STEP NINE:
Now we have quite a collection of  
layer styles we’re going to use to dress 
up this text graphic. First, in your text 
document, click on the Create a New 
Layer icon at the bottom of the Layers 
panel to create a new blank layer, and 
then move it below the text layer in the 
layer stack. Then, fill that layer with 
50% gray by pressing Shift-Delete 
(PC: Shift-Backspace) and choosing 
50% Gray from the Use pop-up menu 
in the Fill dialog. Click OK.

STEP 10:
Click on the Add a Layer Style icon at  
the bottom of the Layers panel and 
choose Pattern Overlay. Then, click 
on the Pattern thumbnail, locate the 
Carbon Fiber pattern at the bottom  
of the Pattern Picker, and click on it  
to select it. Also, drop the Scale down 
to 50%.
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STEP 11:
Click on Gradient Overlay on the left 
side of the dialog to turn it on. Use 
the default Black, White gradient, but 
change the Blend Mode to Overlay, 
turn on the Reverse checkbox, change 
the Style to Radial, the Angle to 180°, 
and the Scale to 150%. Remember, you 
can move the pattern around manually 
if you want by clicking in the image 
window and dragging it around. Click 
OK when you’re done.

STEP 12:
Now, click on the text layer in the Layers 
panel to make it active, then click on 
the Add a Layer Style icon, choose Bevel 
and Emboss, and apply the settings 
you see here. For Gloss Contour, be sure 
to choose the Ring preset, which is the 
second icon in the second row in the 
Gloss Contour Picker.
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Continued

STEP 13:
Click on Pattern Overlay on the left  
to turn it on, then click on the Pattern 
thumbnail and, this time, locate the 
Car Pattern we defined earlier. Drop 
the Opacity down to 85% and increase 
the Scale to 175%. Then, move the 
Layer Style dialog aside and click-and-
drag the pattern around in your image 
window, so you can see some of the 
reflective surface of the car inside  
the text.

STEP 14:
Next, click on Satin on the left to turn 
it on, and then click on the color swatch 
to the right of the Blend Mode pop-up 
menu and choose white. Set the Blend 
Mode to Color Dodge and drop the 
Opacity to 50%. Set the Angle to 14°, 
the Distance to 15 px, and the Size to 
21 px. You can also adjust the satin look 
manually by clicking in the image win­
dow and dragging it around, like we did 
with the Pattern Overlay layer style.
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STEP 15:
Finally, click on Stroke on the left to 
turn it on. Keep the Color set to black, 
increase the Size to 10 px, and make 
sure the Position is set to Outside. 
Click OK when you’re done.

STEP 16:
Now you can see, after all we’ve 
done, that we’ve dressed the text up 
quite nicely with layer styles. Before 
we bring the text into the working 
layout, though, Command-click (PC: 
Ctrl-click) on the carbon fiber layer 
(Layer 1), so that both it and the text 
layer are selected, then Right-click on 
either layer and choose Convert to 
Smart Object. Now, click-and-drag  
or copy-and-paste this smart object 
into the working layout.
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Continued

STEP 17:
With the smart object in your working 
layout, go into Free Transform, press-
and-hold the Shift key, and resize the 
layer, so that the text fits the width of 
the layout (and you don’t see all the 
extra carbon fiber texture on either 
side). Press Return (PC: Enter) to lock  
in the transformation. Add a layer mask  
and then select the Rectangular Mar­
quee tool (M) from the Toolbox. Create 
a selection along the top edge of the 
word, then press-and-hold the Shift key 
(to add to the selection) and create a 
selection right along the bottom edge 
of the text. With your Foreground color 
set to black, press Option-Delete (PC:  
Alt-Backspace) to fill these selected 
areas with black. This will hide the 
excess edge of the carbon fiber tex­
ture. Press Command-D (PC: Ctrl-D) 
to Deselect.

STEP 18:
Go into Free Transform mode again, and 
then Right-click inside the bounding box 
and choose Skew. Press-and-hold the 
Option (PC: Alt) key, then click-and-drag 
the right-middle control handle upward 
to skew the text object to match the 
angle of the car. Right-click inside the 
bounding box again, choose Scale, then 
press-and-hold the Shift key and click-
and-drag the top-middle control handle 
up to increase the size of the text. Press 
Return when you’re done.
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STEP 19:
Now we need to add one more text 
element just above GEAR. Since we’ve 
already gone through the process of 
creating the GEAR text, we can just do 
this by making a duplicate of the Smart 
Object layer and modifying it. However, 
creating a regular duplicate will keep 
the contents of the Smart Object layer 
linked to the duplicate—meaning, if we 
change one, it will change the other. 
So, to make an unlinked copy of the 
Smart Object layer, Right-click on it 
and choose New Smart Object  
via Copy.

STEP 20:
Double-click on the duplicate Smart 
Object thumbnail to open it up. Using 
the Horizontal Type tool, highlight the 
text and type “MAXX.” Then, move 
the text to fit in the canvas area. Lastly, 
click on the Eye icon to the left of the 
background carbon fiber layer to turn 
it off, press Command-W (PC: Ctrl-W) 
to close the document window, and 
save the changes when prompted. 
The new text will then be updated  
in the working layout.
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Continued

STEP 21:
Go into Free Transform again, and scale 
the MAXX text layer down and position  
it just above the GEAR text, so it overlaps 
slightly, like you see here. As an option,  
you can add a Drop Shadow layer style 
to both Smart Object layers to help give 
them a little more depth (as I’ve done 
with the settings shown here). And, as 
a final touch, you could use the flare 
brush from Chapter 1 and add it to 
the specular highlight on the car, as  
well as the text.

In the final image, you’ll see I add­
ed some finishing elements to polish 
the effect. At the top, I created a fake 
version of the Xbox label, with a few  
tweaks of my own. I simply created a 
rectangle on a new layer and filled it  
with white. Then, I added the gradi­
ent element along the bottom of it 
and added the logo and text on top.  
I also threw in the fake rating graphic 
at the bottom. These finishing ele­
ments would normally be handled by 
the manufacturer, but as a designer, 
you must be aware of them and leave 
space in the design to accommodate 
them. Otherwise, critical parts of your 
design can be obstructed.
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Use the Flare brush 
created in Chapter 1.

Use the Flare brush 
created in Chapter 1.

Chapter 4 Commercial Effects

Final Image
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Index

3D design effects, 305–351
3D logo effects, 332–351
3D postcard effects, 319–331
3D text effects, 306–318

3D layers
creating, 341
merging, 312, 325, 338

3D menu, 306, 333, 334
3D panel, 306

Camera tools, 314, 318
Lights options, 314–315, 317, 326–327, 346–347
Materials options, 306, 309, 316–317, 328, 342
Mesh options, 312–313, 325, 338, 339
Object tools, 318
Repoussé feature, 307
Scene options, 315, 329, 348

3D rendering, 315, 317, 329, 348
3D tools

3D Camera tools, 314, 318, 340
3D Light Pan tool, 315, 327, 347
3D Light Rotate tool, 315, 327, 347
3D Light Slide tool, 315, 327, 347
3D Mesh Rotate tool, 312, 325
3D Mesh Scale tool, 313
3D Mesh Slide tool, 312, 338, 339
3D Object tools, 318
video tutorial, 305

50% Gray fill, 11, 89, 197, 230, 273, 324

A
Abrams, J. J., 7
active selections, 45
Add a Layer Style icon, 10, 16, 31
Add Layer Mask icon, 23, 116
Add Noise filter, 299
adjustment layers

Gradient Map, 152, 155, 208
Hue/Saturation, 47, 66, 78, 108, 115, 217, 267, 322
Levels, 36, 259, 311

Adjustments panel
Colorize checkbox, 47, 115, 159, 210, 254, 322
Hue/Saturation adjustments, 47, 66, 78, 108, 115, 217, 

267, 322
Levels adjustments, 36, 216, 259, 311

advertisements
cool watch ad, 164–180
wood frame surf ad, 181–192
See also commercial effects

Alpha channel, 120, 121, 190, 220, 223
Ambient color swatch, 316, 317, 328
Angle Jitter setting, 30, 38, 265
Angle settings

3D object, 340
Bevel and Emboss, 10, 74, 128
Brush tool, 24
Drop Shadow, 92
Gradient Overlay, 53, 90, 198
Inner Shadow, 251
Motion Blur, 9, 12, 300

Animation panel, 238, 254, 258
anti-aliasing noise, 322
aspect ratio, 45
Assorted Brushes preset, 7
Average Blur filter, 64, 69

B
Background color

default setting for, 8, 12, 37
swapping with Foreground color, 15, 94

Background Contents pop-up menu, 146
Background layers

3D layers and, 312
duplicating, 208, 225
filling, 8, 44, 154, 280
turning off, 79, 140, 272

backgrounds
black, 16, 165, 166, 272, 319
changing color of, 66
gradients applied to, 95, 115
white, 76, 119, 172, 186, 219

Bevel and Emboss layer style
brush effects and, 10, 31
commercial effects and, 198
design effects and, 101, 128, 131, 139
type effects and, 74, 81

Bevel settings, Repoussé dialog, 308, 335
binary code effect, 272–278
Black, White gradient, 53, 81, 90, 198
black backgrounds, 16, 165, 166, 272, 319
Black Fill option, 220, 244, 280, 320
black layer masks, 23, 211, 295



357Index 357

black-and-white conversions, 289, 294
Blend If options, 284
blend modes

Color, 184
Color Burn, 187
Color Dodge, 135, 199
Difference, 52
Dissolve, 107, 224
Divide, 209
Hard Light, 48, 78, 137, 158, 217, 250
Lighten, 253
Linear Burn, 71, 121, 211
Linear Dodge, 174
Multiply, 78, 83, 134, 158, 172, 210, 280
Normal, 15, 46, 54, 283
Overlay, 13, 32, 44, 67, 90, 173, 194, 227, 268, 320
Screen, 14, 130, 166, 169, 215, 255, 317
Soft Light, 23, 67, 84, 99, 151, 176, 221, 320
Vivid Light, 251, 275, 284

Blending Options dialog, 23
blood splat effect, 301
blur effects

Average Blur, 64, 69
Gaussian Blur, 167, 170, 172, 178, 209
Motion Blur, 9, 12, 300
Surface Blur, 225

bokeh brush, 2–6
border effects, 243–247
Both Axes checkbox, 3, 25, 38, 266
brush effects, 1–41

bokeh brush, 2–6
custom brush, 19–27
Hollywood-style flare brush, 7–18
similarities in nature, 28–33
virtual paintball, 34–41

Brush panel, 2–5, 24–25, 30, 38, 230
Brush picker, 2, 24, 30
Brush tool

darkening image areas with, 222
saving brush presets for, 5, 17, 19, 29, 35
setting options for, 2–4, 24–25, 30, 38

brushes
bokeh, 2–6
custom, 19–27
flare, 7–18, 47–49, 203, 287
lightning, 28–29, 349
resizing, 32, 49, 280, 349
saving, 5, 17, 19, 29, 35

setting options for, 2–3, 24–25, 38–39, 265–266
splat, 34–41, 301
swirly graphic, 56
text, 58–62

bubble effect, 173
Bulge option, 108

C
Camera tools, 314, 318, 340
channels

Alpha channel, 120, 121, 190, 220, 223
creating new, 188
duplicating, 28, 319
Free Transform mode, 223
Load Selection option, 121, 190, 223, 321
Red channel, 28, 319
RGB channel, 51, 100, 173, 219, 321

Channels panel, 28, 51, 100, 173, 188, 219, 227, 319
Character panel, 80, 124
chrome texture, 343–344
Clear Guides option, 293
clipping masks, 54, 99, 108
Close document command, 202
Clouds filter, 166
color

3D bevel, 310
background, 8, 12, 37
converting to B&W, 289, 294
desaturating, 67, 122, 187
foreground, 8, 12, 37
grid line, 146
painting with, 4
removing from images, 34, 150, 174, 215, 258
sampling, 21, 170, 334
shape, 72
text, 47
texture, 160, 168

Color blend mode, 184
Color Burn blend mode, 187
Color Dodge blend mode, 135, 199
Color Dynamics setting, 39
Color Halftone filter, 341
Color Overlay layer style

commercial effects and, 184, 186
design effects and, 90
Hollywood effects and, 283

Color Picker, 53, 130, 175, 184, 236, 298
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Colorize checkbox
3D effects and, 322
commercial effects and, 159, 160, 168, 191
design effects and, 115, 121, 125
Hollywood effects and, 254, 267, 273, 281, 297
photo effects and, 210, 217
type effects and, 47, 66, 78

commercial effects, 145–204
cool watch ad, 164–180
design with grid elements, 146–153
halftone image effect, 154–163
video game cover design, 193–204
wood frame surf ad, 181–192

composite images
gritty texture composite, 214–218
silhouettes in, 119–126
text added to, 124, 125
themed composite, 233–242

Concepcion, RC, 352
Content-Aware Fill option, 292
Contour Editor, 129
contrast adjustments, 67, 151, 158, 189, 194
Contrast slider, Refine Edge dialog, 243
conversions

color to B&W, 289, 294
layer to Smart Object, 22, 99, 140, 156
path to shape, 246

copying
images, 69, 91, 154, 193
selections, 20, 234, 252
video frames, 239, 254, 258
See also duplicating

cracked effect, 31
Create a New Layer icon, 8, 21, 31, 37
Create a New Light icon, 346
Create New Adjustment Layer icon, 36, 55, 108
Create New Channel icon, 28, 120
Crop tool, 132, 217, 293
Cross, Dave, 352
custom brush effects, 19–27
Custom Shape tool, 71

D
dafont.com website, ix
damaged building effect, 260–271
dancer image, 95, 98, 102–108

darkening
color cast, 121
image areas, 216, 220–222, 238
shadows, 151

Decontaminate Colors checkbox, 63
Define Brush Preset command, 17, 19, 29, 35, 58
Define Custom Shape command, 246
Define Pattern command, 88, 196, 272
Defringe command, 186, 322
deleting

image areas, 45, 280
layer styles, 67, 131
See also removing

Desaturate command, 34, 122, 132, 150, 258
Deselect command, 12, 32, 37
design effects, 87–142

advanced logo effects, 127–142
compositing with silhouettes, 119–126
layer style effects, 88–93
step-and-repeat effects, 110–118
water splash elements, 94–109

Difference blend mode, 52
Diffuse Glow filter, 150, 222
Direct Selection tool, 128, 134
Displace filter, 105
displacement map, 105, 133
Dissolve blend mode, 107, 224
Distort command, 263
Divide blend mode, 209
documents

closing, 202
creating new, 7

Dot halftone pattern, 157
Down & Dirty Designer’s Kit, ix
Down Arrow key, 276
dramatic light effect, 70–71
dramatic photo special FX, 257–271
drawing

lines, 260
paths, 285

Drop Shadow layer style
3D effects and, 349
commercial effects and, 161, 185, 186, 191, 203
design effects and, 92, 139
Hollywood effects and, 277
type effects and, 75, 77

Dry Media Brushes option, 265
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duplicating
Background layer, 208, 225
channels, 28
images, 96, 105, 132, 233, 263
layers, 9, 54, 67
shapes, 75
Smart Objects, 250
See also copying

dust particles, 269–270
DVD tutorials, 354

E
edges

refining for borders, 243–247
removing fringe from, 186, 322

educational resources. See resources
effects

3D design, 305–351
brush, 1–41
commercial, 145–204
design, 87–142
Hollywood, 249–302
photo, 207–247
type, 43–84

Ellipse tool, 111, 127
Elliptical Marquee tool, 138, 170, 177
experimentation, importance of, xiii
Extrude settings, 308, 333, 335, 337
Eye icon, 64, 79, 116
Eyedropper tool, 21, 170, 334

F
Facebook resource, 353
Falloff setting, 327, 346
Fibers filter, 12
file size for projects, x
Fill dialog

50% Gray option, 11, 89, 105, 197, 230, 273
Black option, 220, 244, 280, 320
Content-Aware option, 292
White option, 52, 100, 220, 320

Fill Pixels icon, 259
filling

layers, 8, 21, 89
selections, 37, 45, 56, 100, 121
text, 324

filters
Add Noise, 299
Average Blur, 64, 69
Clouds, 166
Color Halftone, 341
Diffuse Glow, 150, 222
Displace, 105
Fibers, 12
Gaussian Blur, 167, 170, 172, 178, 209
Glass, 133
Grain, 22, 230
Halftone Pattern, 136, 157
Motion Blur, 9, 12, 300
Photocopy, 229
Plastic Wrap, 167
Polar Coordinates, 14, 68
Poster Edges, 23, 157, 209
Smart Sharpen, 216
Surface Blur, 225

flare brush, 7–18, 47–49, 203, 287
flattening layers, 105, 132, 282, 323
Flip Horizontal command, 49, 73, 215, 258
Flip Vertical command, 75, 295
Flip X/Y Jitter checkboxes, 24, 30, 38
flipping

images, 49, 73, 104, 258
layers, 49
shapes, 73, 75
textures, 215

Flow Jitter setting, 4
fonts

resource for free, ix
swirly graphics and, 51
See also text; type effects

Foreground color
default setting for, 8, 12, 37
swapping with Background color, 15, 94

Foreground to Background gradient, 70, 95, 341
Foreground to Transparent gradient

brush effects and, 13, 15
commercial effects and, 149, 165, 166, 189, 195
design effects and, 107, 115, 123
Hollywood effects and, 268, 274, 277, 295
photo effects and, 211, 238
type effects and, 65

frame borders, 243–244
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Free Transform
flipping images with, 49, 73, 75, 104, 295
perspective adjustments with, 293
positioning images with, 155, 173
resizing images with, 64, 193
rotating images with, 72, 181
scaling images with, 15, 20, 54, 76, 128, 137, 257
showing the handles in, 20, 64, 99, 172
skewing text objects with, 201
step-and-repeat feature, 112–114, 261–262
stretching images with, 9, 48, 182
warping images with, 108, 137

fx icon, 67, 103

G
Gaussian Blur filter, 167, 170, 172, 178, 209
glare, enhancing, 10
Glass filter, 133
Gloss Contour

Contour Editor, 129
Ring preset, 74, 131, 198

glow effects
Diffuse Glow, 150, 222
Inner Glow, 134, 283
Outer Glow, 16, 48, 67, 83, 107, 135, 177, 349, 350

Google+ resource, 353
Gradient Editor, 81
Gradient Map adjustment layer, 152, 155, 208
Gradient Map dialog adjustments, 289, 294
Gradient Overlay layer style

commercial effects and, 198
design effects and, 90, 139
Hollywood effects and, 287
photo effects and, 237
type effects and, 44, 46, 53, 81

Gradient Picker, 13, 95, 115, 341
Gradient tool, 13, 65, 94, 149, 341
gradients

Black, White, 53, 81, 90, 198
Foreground to Background, 70, 95, 341
Foreground to Transparent, 13, 65, 107, 149, 211, 268
Linear, 13, 53, 123, 138
Radial, 15, 57, 90, 139

Grain filter, 22, 230
graphics

copying, 171
flipping, 49, 73, 75, 104
rotating, 72
scaling, 15, 20, 52, 54, 64, 76

stretching, 9, 48, 182
swirly, 51–57
text with, 69–84
See also images; shapes

gray fill option, 11, 89, 105, 197, 230, 273, 324
grid elements in designs, 146–153, 350
grid lines

adding selections to, 147–148
creating/showing, 146–147
sizing/resizing, 150
turning off, 148
See also guides

grid pattern effect, 275–277
gritty texture composite, 214–218
grunge effect, 96, 122, 294
guides

clearing, 293
setting, 110, 290
snapping to, 111, 290
See also grid lines

Guides, Grid, & Slices preferences, 146

H
hair retouching, 226
halftone image effect, 154–163
Halftone Pattern filter, 136, 157
Hard Light blend mode

commercial effects and, 158
design effects and, 137, 139
Hollywood effects and, 250
photo effects and, 217, 237
type effects and, 48, 78, 81

Hardness setting, Brush tool, 2
HDR Toning feature

design effects and, 95–98
Hollywood effects and, 279
photo effects and, 233, 236

high-key effect, 219–224
Highlight Mode, Bevel and Emboss, 10, 74, 101, 129
high-tech effects, 272–278
Hollywood effects, 249–302

dramatic photo effects, 257–271
flare brush effects, 7–18
high-tech effects, 272–278
Hollywoodify effects, 279–288
movie poster project, 289–302
title effect, 44–50
touch-up effects, 250–256

Hollywood title effect, 44–50
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Hollywood-style flare brush, 7–18
horizontal flip, 49, 73, 215, 258
horizontal ruler, 110
horizontal streak effect, 9
Horizontal Type tool

3D effects and, 307, 324
commercial effects and, 161, 175, 195
design effects and, 124
type effects and, 44, 58, 80

Hue Jitter setting, 4, 39, 40
Hue/Saturation adjustment layer

3D effects and, 322
design effects and, 108, 115, 121, 125
Hollywood effects and, 267, 273, 297
photo effects and, 217
type effects and, 47, 66, 78

Hue/Saturation dialog
commercial effects and, 159, 160, 168, 191
Hollywood effects and, 254, 281
photo effects and, 210

I
illustrated photo effect, 208–213
images

B&W conversion of, 208
compositing, 119–126, 214–218, 233–242
copying, 69, 91, 154, 193
distorting, 263
duplicating, 96, 105, 132, 233, 263
flattening, 105, 132, 282, 323
flipping, 49, 73, 75, 104, 258
inverting, 17, 29, 55, 215
noise added to, 299
positioning, 91, 99, 123, 149, 162, 172
resizing, 64, 193
rotating, 181
scaling, 64
stock, xii, 19, 51
stylizing, 22–27
texture, 217
See also graphics

Inflate option, 137
ink splats, 34
Inner Bevel layer style, 101, 128
Inner Glow layer style, 134, 283
Inner Shadow layer style, 176, 251, 284, 287, 298
Intensity setting for lights, 347
inversing selections, 32, 37, 51, 76, 91

inverting images, 17, 29, 55, 215
iStockphoto website, xii, 19, 51

K
Kelby, Scott, viii, 352
kelbytraining.com website, ix, 354
kelbytv.com website, 352
Kloskowski, Matt, 352

L
Lasso tool, 34, 63, 171
layer masks, 23, 116, 138, 149, 211, 291
Layer Style dialog, 10, 284
layer style effects, 88–93
layer styles

Bevel and Emboss, 10, 31, 74, 81, 101, 128, 198
Color Overlay, 90, 184, 186, 283
Drop Shadow, 75, 92, 139, 161, 185, 277, 349
Gradient Overlay, 44, 46, 53, 81, 90, 139, 237
Inner Glow, 134, 283
Inner Shadow, 176, 251, 284, 287, 298
Outer Glow, 16, 48, 67, 83, 107, 135, 177, 349, 350
Pattern Overlay, 82, 89, 197, 199, 273, 276
Satin, 74, 130, 135, 199
Stroke, 53, 82, 150, 200

layers
3D, 312, 323, 325
clipping, 99, 108
converting to Smart Objects, 22, 99, 140, 156
creating new, 8, 21
duplicating, 9, 54, 67
filling, 8, 21, 89
flattening, 105, 132, 282, 323
flipping, 49
merging, 16, 56, 79
opacity of, 70, 158, 169, 270
path, 332
resizing, 201, 203, 235
shape, 72, 116
text, 44, 51
unlocking, 275

Layers panel
creating layers in, 8, 21
layer masks added in, 23, 116
layer styles added in, 10
merging layers in, 16, 56, 79
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Left Bracket Key ([), 32, 49, 280, 349
Levels adjustment layer, 36, 216, 259, 311
Levels dialog adjustments

brush effects and, 17, 29, 35
commercial effects and, 169, 189
design effects and, 98
Hollywood effects and, 253, 255, 264, 298, 300

Lighten blend mode, 253
lighting effects

3D object, 314–315, 317, 326–327, 346–347
dramatic light effect, 70–71
warm light effect, 251

lightning brush, 28–29, 348
Line halftone pattern, 136
Line tool, 259
Linear Burn blend mode, 71, 121, 211
Linear Dodge blend mode, 174
Linear gradients, 13, 53, 123, 138
Load Selection command, 121, 190, 223, 321
Load Texture command, 133, 343
logos

3D effects for, 332–351
advanced design effects for, 127–142

M
Magic Wand tool, 36, 76, 91, 151, 257
Make Work Path option, 246
masks

clipping, 54, 99, 108
layer, 23, 116, 138, 149, 211, 291
quick, 178

Material Picker, 306, 309
Materials options, 3D panel, 306, 309, 316–317, 328, 342
merging

3D layers, 312, 325, 338
layers, 16, 56, 79

Mesh options
3D panel, 312–313, 325, 338, 339
Repoussé dialog, 333, 335, 337

mirror effect, 291
Motion Blur filter, 9, 12, 300
Move tool

center aligning text with, 80
dragging-and-dropping graphics with, 52, 77, 324
positioning images with, 91, 123, 149, 162, 172, 194

movie poster project, 289–302

Multiply blend mode
commercial effects and, 158, 172
design effects and, 134
Hollywood effects and, 280, 287, 295, 297
photo effects and, 210, 229, 230, 231
type effects and, 78, 83

N
naming patterns, 88, 196, 272
National Association of Photoshop Professionals (NAPP), 

354
nature, similarities in, 28–33
neutral gray fill option, 11, 89, 105, 197, 230, 273
New document dialog, 7
New Layer with Layer Mask option, 63
New Material option, 306
New Smart Object Via Copy command, 202
New Tool Preset command, 5, 62
noise

adding to images, 299
cleaning up, 322

Normal blend mode, 15, 46

O
Object tools, 318, 340
online training, 354
opacity

drop shadow, 141
layer, 70, 158, 169, 270
text, 48

Opacity Jitter setting, 4, 25, 39, 230
Opasinski, Tomasz, 257
Ornament shapes, 71
Outer Glow layer style

3D effects and, 349, 350
brush effects and, 16
commercial effects and, 177
design effects and, 107, 135, 141
type effects and, 48, 67, 83

Output To pop-up menu, 63, 98, 243, 245
Overlay blend mode

3D effects and, 320
brush effects and, 13, 32
commercial effects and, 173, 189, 194, 198
design effects and, 90, 107, 116, 133
Hollywood effects and, 268, 273, 276, 282, 283
photo effects and, 227, 231, 235
type effects and, 44, 67



363Index

P
padlock icon, 275
paint splash image, 319
paint splat brush, 34–41, 301
painting

with color, 4
with words, 58–68

Pan the 3D Constraint tool, 333
paper texture, 159, 231
particle effect, 238–240, 269–270, 317
Paste command, 20, 69, 91, 155, 172
Patch tool, 292
Path Selection tool, 73, 112, 113, 114
paths

3D logo design, 332–333
converting to shapes, 246
drawing around image areas, 285
loading as selections, 134, 285

Paths panel, 134, 246, 332, 333
Pattern Overlay layer style

commercial effects and, 197, 199
design effects and, 89
Hollywood effects and, 273, 276
type effects and, 82

Pattern Picker, 82, 89, 197, 273
patterns

choosing, 82
grid, 275–277
naming, 88, 196, 272
rotating, 136
scaling, 137, 197
seamless, 88
step-and-repeat, 112–114
See also textures

Pen Pressure setting, 230, 266
Pen tool, 285
Perspective adjustment, 293
photo effects, 207–247

gritty texture composite, 214–218
illustrated photo effect, 208–213
refine edge border trick, 243–247
stylish high-key effect, 219–224
themed composite, 233–242
vintage pinup-girl effect, 225–232

Photocopy filter, 229

photos
composite, 119–126, 214–218, 233–242
stock, xii, 19, 51
stylized, 22–27
texture, 217
See also images

Photoshop CS5 Extended, xii, 305
Photoshop resources, 352–355

NAPP membership, 354
Photoshop World, 355
social media, 353
tutorials, 352, 354
videocasts, 352
See also Web resources

Photoshop User magazine, 354
Photoshop User TV videocast, 352
Photoshop World Conference & Expo, 355
pinup-girl effect, 225–232
Planet Photoshop website, 225, 352
Plastic Wrap filter, 167
Point Light option, 314
Polar Coordinates filter, 14, 68
Polygonal Lasso tool, 160
positioning images

Free Transform for, 155, 173
Move tool for, 91, 99, 123, 149, 162, 172, 195

postcard 3D design effects, 319–331
Poster Edges filter, 23, 157, 209
posters

Hollywood effects for, 279–288
movie poster project, 289–302

presets
brush, 5, 17, 19, 29, 35
effect, 97
tool, 5, 62, 66

pressure-sensitive tablets, xi, 230
projects

file sizes for, x
fonts used in, ix

Q
Quick Mask mode, 178
Quick Selection tool, 20, 98, 186, 234, 280
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R
Radial gradients, 15, 57, 70, 90, 139
Radius slider, Refine Edge dialog, 63, 243
rain effect, 299–300
Ray Traced Draft quality option, 315, 329, 348
Rectangular Marquee tool

brush effects and, 11, 19
commercial effects and, 147, 159, 175, 181, 188, 201
design effects and, 124
Hollywood effects and, 252, 260, 286, 291, 292
photo effects and, 243, 245

Red channel, 28, 319
refine edge border trick, 243–247
Refine Edge dialog, 63, 243, 245
Refine Radius tool, 63
reflections

3D object, 317, 328, 342–345
creating, 286
fading, 166

removing
color from images, 34, 150, 174, 215, 258, 270
fringe from edges, 186, 322
See also deleting

rendering 3D scenes, 315, 317, 329, 348
Repoussé dialog, 307–310, 333, 335, 337
resizing. See sizing/resizing
resources, 352–355

NAPP membership, 354
Photoshop World, 355
social media, 353
tutorials, 352
videocasts, 352

RGB channel, 51, 55, 119, 173, 190, 219, 227
Right Arrow key, 276
rotating

3D objects, 312, 318, 325, 327, 347
images, 72, 181, 223
patterns, 136
shapes, 72

Rounded Rectangle tool, 127
Roundness setting, Brush tool, 8, 24, 47
rulers, 110, 290

See also guides

S
sampling colors, 21, 170, 334
Satin layer style, 74, 130, 135, 199
Saturation adjustments, 97, 159, 160

saving
brush presets, 5, 17, 19
effect presets, 97
tool presets, 62, 66

scaling
3D text, 313
gradients, 15
images, 20, 64, 223, 257
layers, 201, 203, 235
patterns, 137, 197
shapes, 52, 54, 76
See also sizing/resizing

Scatter setting, 3, 25, 38, 266
Scene options, 3D panel, 315, 329, 348
Screen blend mode

3D effects and, 317, 350
brush effects and, 14
commercial effects and, 166, 169
design effects and, 130
Hollywood effects and, 255, 270, 298, 300
photo effects and, 215, 240

Select All command, 80, 193
selections

active, 45
copying, 20, 234, 252
deselecting, 12
filling, 37, 45, 56, 100, 121
grid line, 147–148
inversing, 32, 37, 51, 76, 91
loading paths as, 134, 285
outputting to, 98, 243, 245
positioning, 276
quick, 20, 98, 186, 234, 280
square, 11
transforming, 45

Shadow Mode, Bevel and Emboss, 10, 74, 101, 129
shadows

bevel, 74
drop, 75, 77, 92, 139, 161
inner, 176, 251

Shape Dynamics settings, 2, 24, 30, 38, 265
Shape Layers icon, 127
Shape Picker, 71
Shape tools, 259
shapes

border, 244
choosing, 71
colors for, 72
converting paths to, 246
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duplicating, 75
flipping, 73, 75
gradients in, 13
layer styles for, 74
rotating, 72
scaling, 52, 54, 76, 128
step-and-repeat for, 112–114
stretching, 9, 48
swirly, 51–57
See also graphics

silhouettes
adding to images, 171
compositing with, 119–126
creating from images, 119–121

similarities in nature, 28–33
Single Column Marquee tool, 148
Single Row Marquee tool, 124, 147
Size Jitter setting, 2, 24, 30, 38, 265
sizing/resizing

3D text, 313
brushes, 32, 49, 280, 349
frames, 244
grid lines, 150
images, 64, 193
layers, 201, 203, 235
text, 80, 201
See also scaling

Skew option, 108, 201
sky effects, 258
smart filters, 158
Smart Objects

converting layers to, 22, 99, 140, 156
creating unlinked copies of, 202
duplicating, 250

Smart Radius checkbox, 63, 243
Smart Sharpen filter, 216
smoke/fire effect, 281–282
Smudge tool, 226
Snap To option, 111, 290, 314
social media resources, 353
Soft Light blend mode

3D effects and, 320, 342
brush effects and, 23
commercial effects and, 151, 176
design effects and, 99
photo effects and, 221, 222, 228, 236
type effects and, 67, 84

Spacing setting, Brush tool, 2, 24, 30, 60
spark effect, 251–254
Speckle Grain filter, 22
Specular color swatch, 342
splash effect, 94–109
splat brush, 34–41, 301
Spot Light option, 326, 346, 347
spotlight effect, 316
square selections, 11
step-and-repeat effects, 110–118, 261–262
stock images, xii, 19, 51
stone textures, 31, 310
Stroke layer style, 53, 82, 150, 200
stylish high-key effect, 219–224
Subtract from Shape Area icon, 127
surf ad design, 181–192
Surface Blur filter, 225
Swatches panel, 324
swirly graphics, 51–57

T
text

3D effect, 306–318
adding, 44, 51, 83
brush presets, 58–62
center aligning, 80
colorizing, 47
commercial design, 152, 161, 175–176, 179, 195,  

197–203
composite image, 124, 125
design effect, 124, 139
filling, 324
flares added to, 47–49
gradients in, 44
graphics with, 69–84
Hollywood title, 44–50
layer styles added to, 81–83, 197–200
movie poster, 301, 302
Overlay blend mode, 32
painting with, 58–68
photo effect, 241
sizing/resizing, 80, 201
skewing, 201
swirls added to, 51–57
See also type effects

Texture Picker, 3
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textures
3D design, 310–311, 343–344
brush, 3
chrome, 343–344
colorizing, 160, 168
desaturating, 215
flipping, 215
frame border, 243–244
grunge, 122
loading, 133, 343
naming, 88, 196
paper, 159
photos of, 217
seamless, 88
smoothing, 69–70
stone, 31
wood, 243, 245
See also patterns

themed composite design, 233–242
titles, Hollywood-style, 44–50
Toggle Misc 3D Extras icon, 314, 326, 346
touch-ups, Hollywood, 250–256
Transfer setting, 4, 25, 39, 230, 266
Transform Selection command, 45
tutorials

3D tools video, 305
Kelbytraining.com, 354
Planet Photoshop, 352

Twitter resource, 353
type effects, 43–84

Hollywood title effect, 44–50
painting with words, 58–68
swirly graphics, 51–57
words & graphics, 69–84
See also text

U
Underlying Layer slider, 284
underwater image, 164–180
Undo command, 65
unlocking layers, 275

V
vector shapes, 332
vertical flip, 75, 295
vertical ruler, 110

video frame captures
of particles, 238–239
of skies, 258
of sparks, 254

video game cover design, 193–204
video tutorials, ix

3D tools video, 305
Planet Photoshop, 352

vintage pinup-girl effect, 225–232
virtual paintball effect, 34–41
Vivid Light blend mode, 251, 275, 284

W
Wacom pressure-sensitive tablets, xi, 230
warm light effect, 251
Warp command, 240, 253
warping images

Bulge option for, 108
Inflate option for, 137

watch ad design, 164–180
water splash effect, 94–109
Web resources

dafont.com, ix
iStockphoto, com, xii, 19, 51
kelbytraining.com, ix, 354
kelbytv.com, 352
Photoshop World, 355
Planet Photoshop, 225, 352
See also Photoshop resources

white backgrounds, 76, 119, 172, 186, 219
White Fill option, 52, 100, 220, 320
white layer masks, 138, 212, 277
Whole Scene render option, 315, 348
wood frame surf ad, 181–192
wood texture effects, 243, 245
words

painting with, 58–68
See also text

Z
Zoom tool, 280, 292
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